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CHAPTER 1   INTRODUCTION

About the Program
The program ALL-PILE for Windows version has a user friendly interface, which
makes the program easy to learn and easy to run. It has a powerful pull down menu bar
at the top of screen and is very easy to operate. The commands on the menu bar are
arranged in a Microsoft-style configuration. Mouse and keyboard are available for data
input and retrieval with short-cut keys provided for quick operation.

The program can calculate pile load capacity very efficiently and accurately.  All-Pile
can handle all types of piles: drilled shaft, driven pile, low case auger-cast pile, steel
pipe pile, H-pile, timber pile, Tapered pile, etc...  You can even define new piles and
change some parameters based on local practices and experience. The program can
calculate compression load capacity, uplift capacity, lateral capacity, deflections and
location of point of fixity (Free head and fix head condition), and settlement.

After data is input and the program executed, graphical output showing vertical load
capacity versus pile length relationship and lateral load capacity versus deflection
relationship is provided.  The graphics presentation can be printed as a high resolution
hard copy using your laser printer.

About the Manual
This manual:

1) Describes software operation and hardware configuration
2) Introduces theory and methods of calculation used in the program (the

user should be at least familiar with pile design theory)
3) Describes each input and output parameter
4) Provides typical example problems

About the Company
CivilTech Software is a subsidiary of CivilTech Corporation. CivilTech Software
employs engineers with experience in structural, geotechnical, and software
engineering. These engineers have many years of experience in design and analysis in
these fields as well as in special studies including: seismic analysis, soil-structure
interaction, and finite element analysis. Together, CivilTech has developed a series of
engineering programs which are efficient, easy to learn, engineering orientated,
practical, and accurate.

The series of CivilTech Software includes Shoring, Heave, Lpres, Epres, Tunnel,
Buried Structures, All-Pile, Boring Log, and Lab Testing programs. These programs
are widely used  in US and around the world.
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CHAPTER 2   INSTALLATION

Setup Insert the Setup Disk in a floppy drive.
In Windows 3.1 from the [FILE] menu, select [RUN].
In Windows ’95, press <START>; and select [RUN].
Type:
          A:  INSTALL or B: INSTALL, then press <OK>

then follow the instructions on the screen. The installation program will
automatically create an icon called ALLPILE in your Windows screen.

Configuration Hardware configuration uses your Window’s settings. However, you can
run configuration later in Windows. To run configuration check your
Windows menu book.

Starting the Program Double click the icon called ALLPILE from your Windows screen.

Running the
Calculation

The program will automatically do the calculation once the input is
completed.

View and Print
Results

To view the results, press each corresponding button on the tool bar or
view menu for soil profile, calculation results, vertical and lateral load
curve.

Quit Program Press [Exit] from the [File] menu or Ctrl+X

Registration

You will need to register your copy of this
software to use its full capabilities like
printing and saving your work.  The first
thing you need to do to register is to get
your code number from the software.  This
number is located under the [Help] menu in
the option [Register]. (Figure 2-1)

Figure Chapter 2 -1 Register Menu

Clicking [Register…] will open the
registration window (Figure 2-2) where you
can enter your firm name and get your Code
Number. 

To get your registration code, call, fax, or
email us your Code Number and enter in the

Code Number

Figure Chapter 2 -2  Registration Window
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number we give you in the box next to Registration Code:

If you’ve done everything correctly you should see Figure 2-3 (below).

Figure Chapter 2 -3  Successful Registration Notice

Menu Command
The following text describes the purpose of each command under the menu item.

File Menu

The [File] menu provides easy data file handling tools.

New To clear all the old data from the screen, and provide a blank work space so you can
begin a new job.  Every time you open the program, the program provides you with a
new untitled file.  If the file name is Untitled you have to name the file before you save
it.  (See Save below).

Open To open an existing file saved previously in the hard disk.  A dialog box with a list of 
files will show on the screen.  Select the file you want and click open. If you change
your mind, press Esc or cancel button.

Save Occasionally you should save the file you are working on to avoid losing data. To save
the working file you can press the shortcut key F10, or pull down the file menu and
click on [Save] or [Save As].   If the file is untitled, the program will automatically
switch to  the [Save As] command and ask you to provide a file name to save file.

Save As If you want to save a new untitled file or change the file name of an opened file, you
should use the [Save As] command.  A dialog box appears to ask you the file name you
want to use.  You may type up to 8 letters for file name.  Don't type "." and extension. 
A legal file name cannot contain "# ".  If the file name is not valid, another dialog box
appears to warn you.  You can enter a valid name or click [Cancel] to go back.

Exit To quit the program.

A dialog box will appear.  You have three choices:

1. Click <YES> to save the working file and exit.  A [Save As] dialog box will
appear, see the description of [Save As] command.

2. Click < CANCEL > To go back to the working file.  Does not exit.

View Menu The <View> menu provides easy viewing tools.
Profile: To view soil profile
Report: To view results summary
Lateral Curve: To view lateral load capacity versus displacement

relationships
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Vertical Curve: To view vertical load capacity vs depth relationship

Setting Menu Pile To set parameters related to pile property
Soil To set parameters related to soil property

Help Menu Provides help information for your convenience.

Tool Bar and Buttons
The tool bar provides short-cut buttons for menu commands. Figure Chapter 2 -4 shows
the buttons and their corresponding meaning showing on the screen.  The data button
is provided for easy access to go to data input page.

New File

Open File Save
File Profile Report

Lateral Curve
Vertical Curve

Help

Figure Chapter 2 -4  All-Pile Tool Bar
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CHAPTER 3   RUNNING THE PROGRAM

Data Input
The data needed for calculation basically consists of pile and soil information.  A more
detailed description of the input pages is presented in the following text.  The graphical
definition is illustrated on Figure Chapter 3 -1.

Figure Chapter 3 -1  Data Input Window

Item 1 Project Information: Enter project name and other project identification.

Item 2 Pile Type: Select pile type.

Item 3 Material: Select material type of pile.

Item 4 Loads

Vertical Load:  Enter vertical load applied on the pile

Lateral Load:  Enter to calculate lateral displacement under this lateral load.  This
lateral load is also being used to calculate the safety factor.

Min Length:  Enter the minimum limit to be plotted on vertical curve.

Max Length:  Enter the maximum limit of load to be plotted on vertical curve.

Item 5 Tapped check box : check this box for tapped pile.  If this box is checked, the data
input box will ask for both top and bottom pile diameter (refer to the Pile Profile Table
in Item 6).  Otherwise, only on pile diameter is needed for input.

3
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Item 6 Pile Profile Table

Len. - is the length of pile segment, not the depth

Top Dia. - is the diameter of pile at top of the segment

Bot Dia- is the diameter of pile at bottom of segment (for tappered pile only).

E - is the elastic modulus of pile

Cir. - is the perimeter of pile, it is automatically calculated based on circle shape.  If
the pile is not circle in shape, enter the perimeter of pile.

Area - is the cross sectional area of pile (automatically calculated based on circle
shape.  If the pile is not circle in shape, enter the actual area of pile)

I- is the moment inertia of pile (it will be automatically calculated based on circle
shape.  If the pile is not circle in shape, enter the actual area of pile)

Item 7 Soil Profile

GWT - Groundwater table may be input here. 

Depth Type Friction Cohesion(psf) Density Ksub(pci)
0.00 1.00 30.00 0.0 120.00 12

10.00 1.00 36.00 0.0 120.00 30

20.00 1.00 38.00 0.0 120.00 25

Depth - is the depth of top of the soil layer.  The program can calculate saturated
density based on the input of groundwater table.

Type - is the soil type.  Soil type 1 is sand (C=0, ∅≠0), Soil Type 2 is clay (C≠0, ∅=0),
and Soil Type 3 is C, ∅ soil (C≠0, and ∅≠0)

Density - is the density of soil.  Submerged density is automatically calculated by
program based on groundwater table input.

Ksub - is the constant of coefficient of subgrade reaction of soil.  Note that Ksub is
different than the coefficient of subgrade reaction.  The user should check Ksub
provided in Hint of Data input page for different soil conditions.

33
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Figure Chapter 3 -2  Hint Box

Item 8 Hint Button

When soil strength test results are not available, hint provides the correlation between
Standard Penetration Test and soil strength parameters.  C, ∅ and Ksub.  The
correlation is shown on Figure Chapter 3 -2.

Change Settings

Pile Parameters
The pile parameters provide three setting items: criteria, friction, and earth pressure
coefficient.

Criteria
This table sets the criteria for calculation.

Allowable Disp - is the displacement corresponding to the lateral load capacity.

F.S.  friction (up) - is the factor of safety for uplift capacity calculation.

F.S. friction (down) - is the Factor of Safety for skin resistance calculation in
compression.

F.S. Tip - is the Factor of Safety for tip resistance calculation in compression.

Depth/ Dia. - is the ratio of depth of bearing layer and pile diameter (D/B). 
Experience indicated that end bearing and skin friction increase with vertical effective
stress up to a limiting depth.  Beyond this limiting depth (10B to 40B) the end bearing

2
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and skin friction is almost constant.  Normally, D/B=20 is used.  User may choose
different ratios based on local experience.  User may also change factor.

Friction
This table sets the friction factor for calculation of friction angle between pile and soil.

Note that if the factor is greater than 2 the program reads as a friction angle  δ instead
of a factor.  If the factor input is less than 2, the program read as a factor, which is δ/ φ.
 User may change the default setting based on their own experience. 

Figure Chapter 3 -3  Pile Parameter Window

Earth Pressure Coefficient Kc and Kt

This table sets the earth pressure coefficient to be used in the vertical load capacity
calculation.  Kc is used in compression load capacity calculation and Kt is for uplift
calculation.  Figure 3-3 shows the default setting.  The users may change the default
setting based on experience.

Default Button
A default button is provided for use.  Click default button will set all pile parameters to
the default setting.
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Soil Parameters
The soil parameters provide default settings for parameters related to soil.

Bearing Capacity Factor (Nq)
This table (Figure 3-4) provides Bearing Capacity Factor to be used in the tip resistance
calculation.  The Bearing Capacity Factor is the function of soil friction angle.  Nq1 is
for drilled piles and Nq2 is for driven piles.  The factors shown on Figure 2-5 are
adapted from DM7 Manual.  In general, the factors are considered to be relatively
conservative.  The user may refer to other literature for different input.

Adhesion/ Cohesion
This table (Figure 3-4) provides ratios of Adhesion and Cohesion for different soil
conditions.  The user may change the default settings shown on Figure 2-5 based on
their own experience.

Default Button - Click the default button to reset all soil parameters back to the default
settings.

Figure Chapter 3 -4  Soil Parameters Window

Data Output
ALLPILE provides both summary and detail results. 

The summary results present vertical ultimate and allowable load capacity, settlement
of pile at allowable load capacity, safety factor of load capacity at working load, lateral
deflection under working load, lateral load capacity at allowable deflection for free-
head and fixed-head conditions.
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The detail shows of step by step calculations. 

The program also gives users graphical presentation of soil and pile profile, lateral load
and deflection curve, compression load capacity versus depth curve.  The following is a
list of output the program provides:

• Soil profile with pile configuration.

• Summary

 The summary report provides results for both vertical and lateral analysis.

Vertical Analysis
Ultimate Capacity - Load capacity prior to factor of safety is applied.

Qskin - Ultimate skin resistance

Qtip - Ultimate tip resistance

Qdown - Ultimate compression load capacity, Qdown = Qskin + Qtip

Quplift - Ultimate uplift capacity

Lateral Analysis
Yfixed and Yfree are the lateral deflection under work loading for the fixed head
condition and free head condition, respectively.

Pfixed and Pfree are lateral load capacity for lateral deflection of 0.5 inch for the
fixed head condition and free head condition, respectively.

T is the stiffness factor, refer to Section 3.4 for definition.

Point of fixity is the point with zero deflection.

• Lateral load capacity and deflection curve and detailed results.

• Compression load capacity and depth curve and detailed results.
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CHAPTER 4   CALCULATION THEORY
Pile foundation is widely used to carry the superstructure loads both vertically and
laterally, to resist uplift forces, and control settlement.  There are many different pile
types.  The following are common types of piles: (1) driven H-pile, (2) driven steel pipe
pile, (3) driven concrete pile, (4) driven tapered pile, (5) driven jetted pile, and (6)
drilled cast-in-place pile.  This program uses procedures described in the Foundations
& Earth Structures, Design Manual 7.02, published by Department of Navy, Naval
Facilities Engineering Command for vertical, lateral load capacity and settlement
calculation..

Compression Load Capacity Calculation
Ultimate Compression Capacity can be determined by the following equation:

Qult = Q t = + Qs

Where Qult = ultimate load capacity in compression

Q t = ultimate tip resistance

Qs = ultimate skin resistance

In Cohesionless Soil

Q t = P t N q A t

Q s = ΣΣ (KC) (P 0) (TANδδ) (S)(∆∆L)

Where Nq = bearing capacity factor (This is a function of ϕ.  It can be
modified in Setting/ Soil menu (refer to Section 2.3b)

At = area of pile tip (∆L - of pile segment)

KC = ratio of horizontal to vertical effective stress on side of element
when element is in compression (refer to Setting/ Pile menu, section
2.3a)

Po  = effective vertical stress

δδ  = friction angle between pile and soil

S = surface area of pile per unit length

In Cohesive Soil

Q t = (Nc) At

Q s = ΣΣ CA S∆∆L

Nc = bearing capacity factor

CA = adhesion of each soil layer

CA = ααCC

C = Cohesion of soil

ααC = Factor …. Can be modified in Setting/ Soil menu (refer to
Section 23b)
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∆∆L = thickness of each soil layer

Allowable pile load capacity Q
Q

FS

Q

FSall
t

t

s

s

== ++

Where FSt = Factor of Safety for tip resistance

FSs= Factor of Safety for skin resistance

In this program the individual user may calculate allowable load capacity with different
safety factor depending on nature of the structure.

Settlement Calculation Due to Vertical Allowable
Load

The settlement at the top of the pile consists of the following three components:

Settlement due to axial deformation of pile shaft, Ws

W
Q Q

L
AE

s
p s s

p

==
++( )

( )

αα

Where Qp = point load transmitted to the pile tip in the working stress range

Qs = shaft friction load transmitted by pile in the working stress range (in 
force unit)

ααs = 0.5 for parabolic or uniform distribution of shaft friction

0.67 for triangle distribution of shaft friction starting from zero
friction at pile head to a maximum value at pile point

0.33 for triangle distribution of shaft friction starting from a
maximum at pile head to zero at pile point.

L = pile length

A = pile cross section

Ep = Modulus of elasticity of the pile

Settlement of pile point caused by load transmitted at the point, Wpp

W
C Q

Bqpp

p p==
( )

0

Where Cp = empirical coefficient depending on soil type and method of
construction.

B = pile diameter

q0 = ultimate end bearing capacity
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Settlement of pile point caused by load transmitted along the pile shaft, Wps

W
C Q

Dqps
s s==

( )

( )0

Where C
D

B
Cs p== ++( . . )0 93 0 16

 D = embedded depth

The total settlement of a single pile, W0

W0=(Ws+Wpp+Wps)

Important Note:

The settlement calculation described in this section is for single pile only.  For settlement calculation of
pile group, user should refer to the related literature.

Uplift Capacity Calculation
The Ultimate uplift capacity can be calculated as:

Q ult = ΣΣ (Kt) (P 0) (TANδδ) (S) (H)

Where Qult = ultimate load capacity in tension

Kt = ratio of horizontal to vertical effective stress on side of element when
element is in tension.

Allowable uplift capacity for pile Q
Q

FS
Wtall

ult

u
p== ++

Where Wp = weight of pile

FSu = Factor of safety for uplift

Lateral Load Capacity Calculation
A pile loaded by lateral force and/or moment at its top, resists the load by deflecting to
mobilize the reaction of the surrounding soil.  The magnitude and deflection of the
resisting pressure are a function of the stiffness of the surrounding soils, the stiffness of
the pile, allowable deflection at the top of pile, and induced moment in the pile.  A
general solution for determination of moments and deflections of a pile subjected to
lateral load and moment at the ground surface has been given by Matlock and Reese
(1960). Figure Chapter 4 -1 shows the general nature of the deflected shape of the pile
and the soil resistance caused by the applied load and the moment. 
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Figure Chapter 4 -1 Laterally loaded pile and soil response.

According to a simpler Winkler’s model, an elastic medium ( which is soil in this case)
can be replaced by a series of infinitely close independent elastic springs.  With this
assumption, one can write that

K
P

Xh ==

Where Kh = coefficient of subgrade reaction (1b/in3)

P = pressure on soil (1b/in2)

X = lateral deflection (1b)

Pile deformation and stress can be approximated based on idealized assumptions.  In
our analysis, pile deformation is estimated assuming the coefficient of subgrade
reaction increases linearly with depth. 

K
k Z

Dh
sub==

Where Ksub= constant of coefficient of subgrade reaction

Z = depth(feet)

D = width/diameter of loaded area (feet)

Guidance for selection of Ksub is given in Figure Chapter 4 -2 for fine-grained and
coarse-grained soils.  Please note that Ksub from Figure Chapter 4 -2 should be
multiplied by 1.16 to convert to lb/in3 for the input into the program.
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Figure Chapter 4 -2

Using the theory of beams on an elastic foundation, one can write

E I
d x

dz
k xp p h

4

4 0++ ==

Where EP=Younng’s modulus of the pile material

IP=Moment of inertia of the pile section.

Solving the above equation, we can have the following expressions for pile deflection
and moment at any depth Z for a given lateral force P and moment M.

S A
PT

EI
B

MT

EIZ x x== ++
3 2

M A PT B MZ M M== ++

Where Ax, Bx, and Bm are coefficients, and

T = stiffness factor

 T = 
EI
k

5

Lateral load capacity of pile were calculated for two loading conditions, free-head and
fixed-head conditions.  For the free-head condition, pile cap is assumed to be flexible or
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pile is hinged at the top.  Fixed-head condition is assumed to have rigid cap fixed
against rotation at ground surface.

A pile is considered a long pile when the pile length L>5T.  For a long pile, the
deflection is almost zero at a depth of 2T, which is called the point of fixity.  The soil
from the ground surface to the point of fixity usually provides the greatest resistance. 
For L<2T, the pile is considered to be a rigid pile and does not fully mobilize soil and
pile resistance.  For L>5T, the lateral capacity does not change significantly. 
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CHAPTER 5   EXAMPLES

This chapter presents five examples with different soil conditions and pile type.  These
examples are intended to let users know how to use this program.

Example 1

Timber Pile
Information:

Timber piles are needed to support a structure.  The soils at the site consist of
3 layers of c.φ soil as shown below.  The pile is 50 feet long. 

Question:

Compute its allowable vertical load capacity and lateral load capacity for the
fixed head condition.

Results:

The summary shows that the allowable compress and uplift load capacities are
195.38 kip and 98.71 kip, respectively.  Settlement at allowable capacity is
0.63 inches.  For a working load of 30 kip, the factor of safety will be about 13
for the vertical load.  The lateral load capacity at 0.5 inch displacements for
the fixed head condition is 6.83 kip.
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Example 2

Steel Pile in a Two-Layer Soil System
Information:

A steel pipe pile of 18 inches in diameter is used for support of a structure. 
The soil is type 3 with both friction and cohesion.  The working load is 150
kip.

Question:

What is the allowable compression load capacity if the pile is 50 feet long?

How long will the pile need to be for a working load of 400 kip?

Results:

The summary shows that allowable compression load capacity is 436.59 kip
for a factor of safety of 2.  From the vertical curve and detailed results, you
may find a pile length of 411 feet is needed in order to obtain an allowable
compression capacity of 400 kip.



           CivilTech Software 19

Example 3

Belled Drilled Shaft in Sandy Soil
Information:

A 40 foot drilled shaft with a bell at the bottom is used.  The shaft has a
diameter of 48 inches, and the bell is 96 inches in diameter.  The soil and pile
profile is shown in the figure below.

Question:

What is the allowable compression capacity of the shaft?

Results:

The program indicated that the allowable compression load capacity is
5,653.99 kip.
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Example 4

Driven Concrete Pile
Information:

Precast concrete piles are used to support a building.  The piles to be used will
be circular - 16 inches in diameter and 60 feet driven into thick, clayey soil.

Question:

Computer allowable compression and uplift capacity of each pile.

Results:

The program shows that the allowable compression of each pile is 83.17 kip. 
The uplift capacity is 73.75 kip.
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Example 5

Drilled Auger Cast Pile
Information:

A 50 foot long drilled auger cast pile with a diameter of 14 inches will be
constructed in the soils shown below.

Question:

Compute the allowable compression load capacity and lateral load capacitty at
deflection of 0.5 inches for the free head condition.

Results:

The program shows that allowable compression load capacity at 0.5 inch
deflection is 9.65 kip for the free head condition.


